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March’s Meeting
Our April meeting will be 
highlighted by a presentation 
by MacSpeech, Inc. In case 
you're getting a feeling of  
deja vu, don't worry... you 
really haven't seen this demo 
before. MacSpeech is the 
company who had to cancel 

in December due to the 
inclement weather on the night of our meeting. 
We're sincerely hoping that CEO Andrew 
Taylor won't run into any foul weather this 
time!

The company's latest product, MacSpeech 
Dictate, which premiered at Macworld/San 
Francisco in January, is an entirely new solu-
tion for speech recognition on the Mac. This 
all new product, written from the ground 
up for the Mac, provides amazing accuracy 
with minimal training using the legendary 
Dragon Speech Recognition Engine by Nuance 
Communications, Inc. Andrew will show us 

(March’s Meeting continues on Page 6)
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Our March meeting featured a presentation 
by Olympus America and Berger Brothers 
Camera of Long Island. Dino Thomas and 
Mark Farb showed us gorgeous images 
designed to reveal the capabilities of the latest 
line of Olympus consumer digital cameras. 
Then Bradley and Yvonne Berger “brought it 
home” to Long Island.

Mark Farb showed that as always, good 
lighting technique and careful composition 
can make it difficult to tell if an image was 
made with a high-megapixel camera model 
or an inexpensive point-and-shoot box. Mark 
emphasized that good optics help, of course, 
and Olympus has its tradition of good optics 
from its experience with film-based imaging.

Four distinct camera lines are offered 
now by Olympus. The FE series, derived 
from the previous D series, cameras stress the 
fun and easy aspect of imaging. One model 
(the $150 FE310) features an 8.0 Megapixel, 5 
X-zoom camera using readily available AA-type 
batteries. with digital image stabilization 
(reducing blur from vibrations at slow shutter 
speeds) and facial detection software, its larger 
sensors reduce noise at high ISO settings for 
improved shadow detail. The FE 340 and 350 
add features, wide-angle capability, and more.

The Stylus series of cameras is now two 
series: the STD series has digital image stabi-
lization, reduced shutter lag time (between 
pressing the button and recording the image), 
and the ability to preview different white bal-
ance settings, but is not weatherproof. The 
SW versions add the Shock and Waterproof fea-
tures, with all-weather and macro capabilities 
including a macro LED light source for uni-
form illumination in extreme close-up images.

The SP Series cameras feature extremely 
great zoom ranges (20X optical zoom, which 
is 26-520mm for a 35mm film camera. Wow! 
These models now shoot in the RAW format 

(April’s Meeting continues on Page 6)

General meeting time schedule:
Meetings are held at The New York Institute of Technology,
Building 300 (Anna Rubin Hall), Old Westbury, Long Island.
Meetings start promptly at 7:00 p.m.
Bradley Q&A 7:00–7:30 p.m.
Beginner’s Q&A 7:00–7:30 p.m.
Featured presentation 7:30–8:20 p.m. followed by 
announcements and raffle drawings.
SIG (Special Interest Group) meetings 8:30–10:00 p.m.
Photoshop SIG:  How to use the RGB channels in Photoshop. How to 
add spot colors to Alpha Channels. How to create a four-color effect 

with just two channels (for hard-core 
graphic arts professionals).
Multimedia SIG: Join us for training in all 
of Apple’s Video programs!
MacBasics SIG: An introduction to 
iMovie.
| In bad weather, call (516) 686-7789.
| The next LIMac board meeting will be at the 
Plainedge Library, (516) 735-4133, 
on Wednesday, January 16th, at 8 p.m.  

Photo: Bill Medlow
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Bill Medlow
President
ArchBill@opton-
line.net

| Encountered after the meeting: 
If you have just installed the Security Update 
2008-02 in Mac OS 10.5.2 Leopard, and you have 
lost the ability to print and you have either 
Audio Hijack Pro or Airfoil installed, you need 
to update them to print again. Who would 
have thought these audio related add-ons 
could affect printing?
| I have documents created in the old 
Broderbund’s Print Shop Deluxe from Mac 
OS 9. I can’t find anything that will open 
these files. How can I convert these files to 
something I can use under Mac OS X on my 
new Mac?
I would just buy ($69.95) Software MacKiev’s 
The Print Shop 2 for Mac OS X. It’s universal 
binary (Mac OS 10.2-10.5) and should be able to 
open the old format files. It now ships with a 
full-color 184 page softcover User Guide. It 
integrates with iLife and does far more than 
the old OS 8/9 version. After Broderbund sold 
out to The Learning Company and they didn’t 
want to deal with the Mac products any more, 
MacKiev stepped in and updated the programs 
that still had a following, or in other words, 
they could make money with. That includes 
KidPix and World Book.
| I’m looking for a SCSI Castlewood ORB 
drive for my old Power Macintosh 8100 
with a dead CD-ROM drive, but got a cheap 
external CD burner, but I can’t install Toast 
without a working optical drive. I was 
going to install Toast through that.
I would suggest downloading Toast 5 from 
Roxio and I don’t see how and ORB drive 
would help, as the software comes on a 
CD-ROM, not an ORB disk.
| The 8100 doesn’t have a modem, so it’s 
not connected to the Internet.
OK, I see. If you have a friend who does have a 
working optical drive or Internet access, and a 
copy of Stuffit Deluxe, you can compress and 
segment Toast 5 onto a series of six HD floppies, 
that would work. You could try replacing the 
internal CD drive. Problem there is, it is SCSI 
and nobody makes SCSI internal drives any 
more. I see a used, but tested, working, Apple 
24x SCSI CD-ROM drive on eBay going for 
$9.99 The original model was just 2x. I also see 
a 12x model for $12.50. As the ORB was pretty 
rare, maybe you can find a friend with an (Q&A continues on Page 3.)

This time of the year is always our busiest: 
The weather is warmer, the days are longer, 
members are starting to come back from 
warmer climates, and this year, we have some 
great Spring presentations:

In March, we had Olympus with its world-
renowned cameras (including one camera for 
the raffle prize).

In May, we will have Dave Marra (an iPod 
is in the works for that raffle).

Attend these exciting meetings; bring a 
friend. (Don't forget, if you bring a new person 
who becomes a member, you’ll save $12 from 
your membership dues! 0

(Continues on Page 3)

external SCSI Zip drive which was common, 
they could copy Toast onto a Zip disk, loan you 
the disk and drive, cables and power supply so 
you could install Toast. You can’t boot off the 
external burner, so I’d buy the replaement 
drive to kill two birds with one stone, get the 
bootable drive back in working shape and then 
able to install other software, besides Toast to 
get files off the old 8100. You need only ordi-
nary screwdrivers to remove the case (top and 
sides) and replace the drive from its plastic 
drive sled.
| Is there anyway to access an image in 
iPhoto directly in Photoshop? Do you have to 
export to the Desktop or go rooting through 
your Pictures folder?
Just change the iPhoto preferences’, General 
category, where it says double-click photo, make 
sure Edits photo is selected and below that, for 
the Edit photo: pop-up menu, change the 
selection to In Application... and then select 
Photoshop. For example, my pop-up currently 
shows, for Edit photo: In Adobe Photoshop CS3... 
Now you can either double-click on an image 
or Right-Click (Control-Click on one button 
mice or trackpads) and select Edit in external 
editor from the pop-up menu. So then when 
you edit an image in Photoshop, save changes 
and close and go back to iPhoto, it should build 
a new thumbnail and you should see the edited 
photo in a few seconds back in iPhoto. Now, of 
course, it would be safer to make a duplicate of 
the original in iPhoto (Command-D) before 
editing.

Select individual 
columes from tables 
in Firefox: 
If you hold down the 
Command key and Click-

Drag inside a table, you can select the data 
just in one column (or any contiguous, reg-
ular shaped block) of cells. 

Info about files downloaded to Firefox:

If you’re a Firefox user, you probably know 
about its Downloads window (press 
Command-J to open it). But did you know 
that if you select one of your downloads in 
the window and press Command-I, you can 
see from where the file was downloaded and 
to where in your system it was downloaded?
Pretty simple, but useful.

Open typed URLs in new tabs in Firefox:

If you type the name of a Website in Firefox, 
i.e. apple.com, then hit Option-Return 
instead of Return, it will open up apple.com 
in a brand new tab. You must have tabs 
activated for this to work.

Easily open a URL from Safari in Firefox:
I’ve seen other ways to go about this, but 
here’s a nice and clean way to switch from 
Safari to Firefox on a misbehaving page. 

First, make sure you have the Safari Debug 
menu enabled. 

On the Debug menu in Safari, the Open 
Page With menu item will list your installed 
browsers; assuming you have Firefox 
installed, you’ll see an entry for Open Page 
With » Firefox.app. 

Now quit Safari, and go to the Keyboard & 
Mouse System Preferences panel, click on the 

 TIP!
Horizontal Tools 
Panel in Adobe 
InDesign CS3 :
“Is there a way to 
make my Tools 
panel horizontal?,” 
a designer asked in 
a recent class. “It 
keeps getting in 
the way when I’m 
working on the far 
left side of my 
layout.” I answered, 
“Sure! If you find 
this happening all 
the time, you may 
want to change 
your Preferences 
(Command + K )and 
look at the top of 
the Interface sec-
tion). But if you 
want to display 
your Tools as a hori-
zontal row tempo-
rarily, first you’ll 

have to undock the 
panel (if it’s 
docked) by clicking 
and dragging from 
its title bar. Then 
click on the small 
double arrows to 
the left side of the 
title bar. This will 
change the 
configuration of 
your Tools panel, 
with each click, 
from a single col- 
umn to a single 
horizontal row to 
the familiar double 
column [from CS2]. 
To redock your Tools 
panel (no matter 
what the config-
uration), click and 
drag from its title 
bar to the far left 
side of your screen. 
When a highlight 
appears, release 
your mouse and 
the panel will be 
docked in a vertical 
format.
–Jeff Witchel
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 TIPS!
Id Macworld’s edi-
tors were asked 
which new Leopard 
features have 
pleasantly sur-
prised them most, 
many (but defi-
nitely not all) 
would put Spaces 
on that list. It’s one 
of those features 
that, once you start 
using it, you find 
all sorts of handy 
things to do with it. 
(Rob Griffiths, for 
example, runs his 
Windows virtual 
machines in Spaces 
of their own.)

Here are a few of 
the tricks and tips 
we’ve learned for 
using Spaces – 
along with Exposé 
and Dashboard – as 
efficiently as pos-
sible.

Spaces & Exposé
Navigate Spaces 
with the 
Keyboard:
 Spaces supports 
numerous keyboard 
shortcuts. For 
example, to display 
an overview of all 
your spaces, press 
F8. In this view, 
you can use the 

(Q&A continues onPage 6)

arrow keys to move 
between spaces, 
press the spacebar 
or return to display 
the selected space, 
or simply type a 
space number to 
display it instantly 
(spaces are num-
bered sequentially 
from left to right, 
starting in the top 
left corner). To 
move directly to 
another space, hold 
down the Control 
key and type that 
space’s number. To 
cycle from one 
space to the next, 
hold down Control 
and press an arrow 
key. (You can, of 
course, customize 
these shortcut keys 
in the Exposé & 
Spaces Preference 
pane.)
–Joe Kissell

Move All Windows 
at Once: 
What if you want to 
move all of an 
application’s win-
dows to another 
space? Sure, you 
can drag them one 
by one, but that’s a 
pain. Instead, hold 
Cont. on Page 4)

| I’ve found that deleting an image in 
iPhoto, it’s still there when I dig through 
the Pictures folder and I have to really drag 
it to the trash in the Finder in this way. 
There has to be an easier way.

There certainly is. When you trash an 
image in iPhoto, similar to how the Finder 
works, it’s just moved to iPhoto’s Trash. You can 
see the tiny Trash icon in the Recent section of 
iPhoto’s sidebar. You can even click on this icon 
to see what is still in iPhoto’s trash. You can 
go to the iPhoto menu and select Empty Trash 
even if you are currently looking at the Trash 
contents.

Conversely, if you wish to rescue some-
thing from iPhoto’s Trash, highlight it and 
select from the Photos menu, Restore to Photo 
Library or just drag it to the desired album. 
iPhoto can get confused and it’s database dam-
aged if you mess around in the iPhoto Library 
folder. Apple made the iPhoto Library into a 
package with the latest version of iPhoto to dis-
courage users from messing around in there.
| I’ve been building up a collection of 
photo and music. Should I move my stuff 
to a backup drive and free-up space on my 
internal drive? I would imagine over time 
you would slow down the workings of the 
computer when you fill up the hard drive.
While that is an option used frequently by 
users of laptops which usually have small 
internal drives that fill up quickly, the problem 
is the other drive is supposed to be a backup of 
data on the internal drive. If you delete it off 
the internal, then you no longer have a backup. 
Backing up data implies there are two or more 
locations. You would be left with just one. 
Who is to say your external drive won’t fail 
first, leaving you with nothing. If you bought 
a second external drive for extra storage space, 
if you move your music and photos onto it 
(implying that they are no longer on the 
internal drive) then you will not have them if 
you take the computer away without the new 
drive. It certainly is true, that as you fill up a 
hard drive, it will work slower, most notably 
when you have less than 10% left. You might 
want to consider backing up everything on the 
internal drive and putting in a bigger internal 
drive. Some older Macs can only accomodate 
internal drives up to 120GB.  Of course if your 

Keyboard Shortcuts tab, and create a new 
keyboard shortcut. Choose Safari as the 
application and enter Firefox.app as the menu 
title. I chose Command-Option-R as my 
shortcut, but feel free to choose whatever 
you think logical. Relaunch Safari and try 
your new shortcut. Note the same trick works 
with any browser in the Open Page With sub-
menu. 

On my machine, Firefox was listed without 
the .app extension, so that’s what I used for 
the new keyboard shortcut. Just match what 
you see in the menu on the shortcut panel 
and it should work fine. Note that if you have 
Saft installed, you’ll have to remove it to add 
new shortcuts – at least I had to. With Saft 
installed and active, newly assigned short-
cuts didn’t show in the Debug menu. They did 
appear when I launched Safari after removing 

Saft, though.

Use Google Toolbar as a simple Firefox:
This may be an obvious hint to power users, 
but I haven’t seen it anywhere else so what 
the heck. Ever since I switched to Firefox, I’ve 
been missing Safari’s quick-and-easy auto-fill 
feature. True, there are Firefox add-ons, but 
I’ve found them either to be buggy or way too 
complicated. All I want is a simple, no fuss, 

one-click form filler. Here’s a way to get it. 
Download Google Toolbar, which includes 

an auto-fill button. It also comes with several 
other functions that I didn’t want and that 
take up a lot of screen space, especially on a 
laptop. To keep things nice and neat, go to 
View>Toolbars>Customize. Drag the Google 
autoFill button into your Firefox toolbar. Click 
Done. Go to View >Toolbars and uncheck 

More of Bradley’s Tech Session 
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computer is getting old, then hard drive is 
getting more likely to fail, and a replace-
ment drive would be safer and more likely 
faster and higher capacity. Also you will 
need to show iPhoto and iTunes where to 
find your stuff, as they won’t be in their 
expected locations. Not a problem for 
iTunes, as you can set the location in it’s 
Preferences in the Advanced category. 
iPhoto needs a little help, in the form of the 
shareware iPhoto Library Manager. See 
http://www.fatcatsoftware.com/iplm/  The 
free version will be enough for the task of 
redirecting iPhoto to use a library in a non-
standard location.
| Is there a way to selectively back up 
whatever is not already backed up? I did 
a backup of everything quite a while 
ago.
You should, of course, back up more fre-
quently, depending on how much you can 
afford to loose. Generally, I would suggest 
a program like Super Duper! that can do a 
Smart Backup. It scans your primary hard 
drive and compares it to the backup drive, 
and only backs up whatever is new or 
changed since the last backup. The backup 
would be identical and bootable (assuming 
we are still talking about backing up the 
primary boot volume) The program can be 
set to automatically backup every day or 
every week. If you set the Energy Saver 
System Preference Schedule, you can have 
the computer start up or wake up a couple 
of minutes before SuperDuper! is timed to 
backup and then SuperDuper!’s options 
could be set to automatically, after com-
pleting the backup, either sleep or shut-
down your Mac. Great for unattended back 
ups in the middle of the night. Having a 
up-to-date bootable clone of your hard 
drive is great when something goes terribly 
wrong. Leopard has a backup program 
included called Time Machine, but it’s back 
ups are not bootable and of course not 
everybody is running Leopard. 
SuperDuper! 2.5 works with Tiger as well. If 
you are still running Jaguar 10.2 or Panther 
10.3, there are older versions available. 
(v2.1.4 and v1.5.5)

http://www.fatcatsoftware.com/iplm/
http://www.google.com/tools/firefox/toolbar/FT3/intl/en/index.html
http://www.shirt-pocket.com/SuperDuper/SuperDuperDescription.html
http://www.apple.com/macosx/features/timemachine.html
http://www.shirt-pocket.com/mint/pepper/orderedlist/downloads/download.php?file=http%3A//www.shirt-pocket.com/downloads/SuperDuper%211.5.5.dmg
http://www.shirt-pocket.com/mint/pepper/orderedlist/downloads/download.php?file=http%3A//www.shirt-pocket.com/downloads/SuperDuper%212.1.4.dmg
http://www.apple.com/macosx/features/spaces.html


The following is just a small sampling of the 
vendor offers available to LIMac members. 
Please visit the LIMac Bulletin Board at www.
limac.org/invboard/ for a complete, up-to-date 
list.
eMedia Music offers a line of award-winning 
and critically acclaimed software for learning 
guitar, piano and more. Guitar Method 
CD-ROM includes 165 step-by-step lessons with 
over 50 large-format videos featuring songs 
from Bob Dylan, the Rolling Stones and more. 
Piano & Keyboard Method includes over 300 
lessons from a former Juilliard instructor. Learn 
to read music and play songs. Provides specific 
interactive feedback on your playing. Over one 
million have learned to play the eMedia way… 
it’s the easiest way to learn – guaranteed. This 
user group special offers Guitar Method or 
Piano Method for only $44.96, regularly $59.95. 
Start learning to play today:Piano: www.emedia-
music.com/macuser_PKM  Guitar: www.eme-
diamusic.com/macuser_GM1 This offer is valid 
through April 30, 2008.
“A Memory Upgrade For Your Brain” iData 
3 is a flexible database for storing (and easily 
retrieving) freeform text, field-based text, 
images, links, and more. It is highly user-con-
figurable, but has well-chosen default settings, 
making it easy for anyone to begin using right 

away. iData 3 imports e-mail, bookmarks, and 
more; lets you design and print envelopes and 
labels; and even dials the phone. User Group 
price: $49.95, way below the regular price of 
$69.95. www.idata3.com/id3mug.html. Coupon 
code: iD3MUG438. This offer is valid through 
April 30, 2008.
YourView, an innovative video tagging applica-
tion, allows users to tag video at the touch of 
a button to create highlights, filter, watch and 
share, turning hours of boring video into 
favorite moments. YourView exports your clips 
straight into iMovie HD/08, and allows you to 
publish to YouTube and the video-sharing com-
munity, or share with family and friends via 
your iPhone, iPod Touch or Apple TV. This user 
group special offers YouView for $14.99, which 
is half the retail price of $29.99. www.yourview.
tv/offer. Promotion code: MUG123 This offer is 
valid through April 30, 2008.
SMART Utility is an application to scan the 
internal hardware diagnostics system of hard 
drives. SMART is a system built into hard drives 
by their manufacturers to report on various 
measurements of a hard drive’s operation such 
as mechanical or electrical problems, and poten-
tial failure. SMART Utility can read and display 
all of these attributes that hopefully allows time 

Google Toolbar, which will hide it (except for 
the button you just moved). 

Now set up auto-fill. Go to Tools>Add-Ons 
and click on the Google Toolbar for Firefox 
add-on. Go to Preferences>Features> AutoFill 
Settings. Fill in your info. The next time you 
come across a Web form, the fields for name, 
address, etc., will automatically turn yellow, 
letting you know that they can be filled in 

with a single click. As I noted, this is a basic 
form filler – it doesn’t support multiple 
names and addresses. But I didn’t need any-
thing that complicated, and I suspect a lot of 
other people don’t either.

Resume browsing session in Firefox:
I often need to restart my computer or quit 
Firefox to free up RAM, but don’t want to lose 
all my open tabs. I find the following solu-

tion by accident: Force quite Firefox (Cmd-
Opt-Esc), and the next time you launch 
Firefox it will ask you if you want to restore 
your session and will load all the tabs and 
windows you had open before the quit. A 
hack, yes, but a useful feature not imple-
mented in the normal interface!
–Mac OSX Hints

Firefox 2.0
Pros
Standards-compliant rendering engine; easily 
extensible with powerful add-ons.
Cons
Sluggish loading and tabbed browsing; lacks 
some useful interface features.
With its ready-for-anything rendering engine 
and amazing expandability, Firefox 2.0.0.12 is 
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Helen and
Sheldon Gross
shel9@verizon.net

Note: Sore Eyes site 
referrals are for your 
information only. 
Neither the Grosses 
nor LIMac endorse 
any of the sites or 
their products.

We’re writing this column from the VIP lounge 
at the airport in Quito, Ecuador. The trip was 
very exciting as we visited Machu Pichu in 
Peru and the Galapagos Islands off the coast 
of Ecuador where everything except natural 
changes happens very quickly, and no trains 
or planes leave anywhere near their scheduled 
time.

There are advantages to traveling with 
the computer. We can download our photos 
from the camera every day and do not need to 
change the card in the camera. That’s great. 
Of course, we have so many pix that the hard 
drive is filling up. Luckily, when we left home, 
I threw a keychain storage drive into the 
suitcases. I’m now sold on this gadget. If you 
don’t have one, I suppose you could just toss a 
few blank CDs into the bag, but the key chain 
device is so much simpler.

     Sore Eyes
The biggest advantage is having varying 

e-mail accounts. Depending upon the wire-
less connection, some do not work every-
where. Usually you can read anything, but 
not send e-mail. I mentioned this factor when 
we were in China because China doesn’t (or 
maybe didn’t) accept Verizon and, there, I 
used Google. But I have had trouble in South 
America, Peru and Ecuador (in particular), and 
the only thing that let me send e-mail there 
was Dotmac. Have them all; it’s loads of fun!

Of course, the best part of traveling with 
the computer is the availability of constant 
two-way communication with those at home. 
It’s much better than postcards. Having a 
wonderful time. 

“Wish you were here.” 
We should be back in the USA tomorrow – 

if LAN airlines ever takes off. More later on. 0

User Group News

George Canellis
gwc11713@optonline.
net

(User Group News continues on Page 6)

(Continues from Page 3)

(Continues on Page 5)

(Cont. on Page 5)

down the shift or 
command key 
before you click 
and hold on a 
window. Then, 
still holding down 
that key, drag one 
window of a pro-
gram; all that pro-
gram’s other 
windows will 
follow. You can 
use a similar trick 

(Cont. from Page 3)

to move just one 
window to the 
exact same physical 
location in a new 
space. Say you’ve 
got a Finder window 
open, and it’s about 
200 pixels below 
and 200 pixels to 
the right of the 
Apple menu. To 
move this window 
to the exact same 
position in another 
space, start drag-
ging the window, 
and then press and 
hold the shift key 
before you drop the 
window into the 
new space. When 
you drop the 
window, it will 
move into the same 
position it had in 
the first space.
–Rob Griffiths

Assign an 
Application to All 
Spaces:
By default, a 
window will stay in 
the space that was 
active when you 
opened it – so an 
application may 
have one or more 
open windows in 
several spaces. If 
you want all of an 
application’s win-
dows to appear in 
every space, go to 
the Exposé & Spaces 
preference pane, 
choose the Spaces 
tab, click on the 
plus-sign (+) 
button, navigate to 
the application, 
and click on Add. 
Then choose Every 
Space from the 
pop-up menu in the 
Space column next 

http://www.limac.org/invboard/
http://www.limac.org/invboard/
http://www.emedia�music.com/macuser_PKM
http://www.emedia�music.com/macuser_PKM
http://www.eme�diamusic.com/macuser_GM1
http://www.eme�diamusic.com/macuser_GM1
http://www.idata3.com/id3mug.html
http://www.yourview.tv/offer
http://www.yourview.tv/offer
mailto:shel9@verizon.net
mailto:gwc11713@optonline.net?subject=April User Group News
mailto:gwc11713@optonline.net?subject=April User Group News
http://maps.google.com/maps?f=q&hl=en&geocode=&q=quito+ecuador+airport&sll=37.0625,-95.677068&sspn=52.107327,70.400391&ie=UTF8&t=h&z=15&iwloc=addr
http://maps.google.com/maps?f=q&hl=en&q=Machu+Picchu,+Cuzco+Peru&ie=UTF8&lr=lang_en&cd=1&geocode=0,-13.162849,-72.515821&ll=-13.165074,-72.520752&spn=8.081034,8.800049&t=h&z=7&iwloc=addr
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Ilene Strizver
Ilene@thetypestudio.
com

Ilene Strizver, 
founder of The Type 
Studio, is a typo-
graphic consultant, 
designer, writer and 
specializing in all 
aspects of typo-
graphic communica-
tion, from the 
aesthetic to the 
technical. Ilene 
conducts Gourmet 
Typography Training 
internationally. For 
more information, 
visit www.the-
typestudio.com.

a superb choice for power users who want to 
do more than simple surfing. It’s a polished, 
professional alternative to Safari.

Firefox’s Gecko engine renders standards-
compliant HTML, CSS, and JavaScript with 
barely a hiccup. In my testing, complex 
pages that gave Safari heartburn – such as 
the multilayered interactive menus of azcen-
tral.com’s entertainment page – loaded flaw-

lessly in Firefox.
Firefox is also full of nice interface 

touches, from the easy ways to clear private 
data to the handy scrollbar that lets you zip 
through multiple tabs. Even better, that 
interface is extremely customizable. Firefox 
supports free, user-created add-ons that 
extend its capabilities. You’ll find hundreds 
of those add-ons on the Mozilla site, from 
the popular GreaseMonkey (which lets users 

add new abilities to existing sites) to add-
ons that block malicious scripts, create and 
edit blog posts, and more.

Though Firefox’s default interface is 
already clean and appealing, you can down-
load themes to personalize its look-and-feel. 
And while Firefox’s built-in search defaults to 
Google, you can expand it to include every 
major search engine, along with such popular 
sites as Flickr and Wikipedia.

Unfortunately, enabling new add-ons 
requires you to restart the browser. That can 
be a pain, since Firefox isn’t exactly speedy 
to load. In my testing, Firefox took anywhere 
from three to eight seconds to fully load, 
compared to between one and three seconds 
for Safari. 
–Nathan Alderman 0

(Continued from Page 4)
(Continued from Page 4)

(Cont. on Page 6)

Spacing of Periods
Q. I don't like the awkward spaces that 
result when superscript characters or quota-
tion marks are followed by a period. Do you 
kern the period to the left so it’s positioned 
under the quote marks or superscript?
A. Yes, those awkward spaces do look bad and 
can interrupt readability. To achieve a more 
professional look for any combinations that 
result in this kind of gap, kern the pair of char-
acters to reduce the space. In the case of the 
superscript followed by the period, you might 
get a better result if you put the period before 
the superscript, then reduce the kerning.

How much to kern is a matter of taste and 
the font in question, but my preference is to 
have the two characters almost aligning. 

Awkward spacing can result around a period next to certain charac-
ters, as shown in the top example, set in Linotype Memphis. You can 
improve spacing with custom kern pairs, as illustrated in the bottom 
example.
True Primes
Q. I’m a textbook designer who has been 
around long enough that some of my ear-
liest books were set in hot metal. In your 
previous column the straight marks you 
referred to as primes aren’t really primes. 
True primes for inch and foot marks are 
slanted like an acute accent (for example, é).
A. I agree, the straight marks in most fonts 
aren’t primes from a historical point of view. 
They’re typewriter characters that were used as 
both quotes and primes.

Unfortunately, when typewriters transi-
tioned to computers, most typefaces main-
tained the straight typewriter quotes instead 
of offering the angled ones, which is why 
most fonts don’t have correctly angled primes. 
Several symbol and Pi fonts, as well as some 
of the newer OpenType fonts, do have true 
primes in addition to smart quotes and old-
fashioned typewriter quotes. Those typefaces 

include Adobe's Universal News & Commercial 
Pi, Symbol, Linotype European Pi, Bigelow & 
Holmes’ Lucida Math, Linotype Mathematical 
Pi, and Linotype Universal Greek with Math Pi, 
and Adobe's Arno Pro and Hypatia Sans Pro.

I refer to straight typewriter quotes as 
primes because that’s what most designers are 
familiar with, and because most fonts don't 
have true primes. But strictly speaking, you are 
absolutely correct.

The difference between typewriter quotes (upper left), which are 
often used as primes, and true primes (upper right) are obvious in 
this example set in Adobe’s Arno Pro, one of the few typefaces that 
has true primes. The typographically correct smart quotes are on the 
second line of the figure.
Word Spacing in Text
Q. Is there a way to adjust the word spacing 
for a block of text that is set flush left, rag 
right? 
A. As you’ve already noticed, the built-in, pre-
determined word spacing varies from font to 
font. In addition, the word spacing’s appear-
ance varies depending on the point size of the 
setting. The spacing should not be so little that 
the words start to run into each other, and not 
so much that your eye has trouble reading 
groups of words because it’s interrupted by 
large white blocks.

Word spacing that is too tight (upper left) or too open (upper right) 
can reduce readability. The bottom example shows appropriate word 
spacing for best readability and good color and texture. Set in House 
Industries Neutraface. 0

to that applica-
tion’s name. The 
Every Space setting 
is appropriate for 
applications you 
use constantly, 
such as Stickies, 
iTunes (especially if 
you have the 
window minimized 
to the controller 
view), and iChat. 
–Joe Kissell

Assign the Finder 
to All Spaces:
Each space has its 
own set of Finder 
windows – so if you 
want access to one 
folder in several 
different spaces, 
you’ll have to open 
a new Finder 
window in each 
space. If you find 
this annoying, you 
can set the Finder 

to be the same in 
all your spaces. To 
do this, follow the 
preceding instruc-
tions for assigning 
an application to 
all spaces, but  
navigate to the 
System/Library/
CoreServices folder 
and select Finder.
–Joe Kissell

The Same Finder in 
Every Space: 
If you want the 
Finder (or any other 
program) to appear 
in all your spaces, 
choose Every Space 
from the Space 
drop-down menu in 
the Spaces prefer-
ence pane.

Change the Space-
Switch Delay: 
When you drag a 
window to the edge 
of your screen and 
hold it there for a 
moment, you move 
that window to the 
space next to that 
edge of your screen. 
The default delay 
before the window 
moves to the next 
space is 0.75 sec-
onds. To change 
that delay to half a 
second (for 
example), open 
Terminal and enter 
defaults write com.
apple.dock work-
spaces-edge-delay 
-float 0.5. Press 
Return, and then 
enter killall Dock. 
You can replace 0.5 
– half a second – 
with whatever 
value you wish. To 
return to the orig-

(Cont. from Page 3)
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to backup data, and replace the drive. Receive 
25% off regular $20 retail price of the 10-unit 
license. www.volitans-software.com. Coupon 
code: CPNAMUG1 This offer is valid through 
April 30, 2008.
LaCie d2 DVD+/-RW 16X Firewire DVD 
burner with LaCie’s LightScribe disc labeling 
technology and Toast 7 Titanium recording 
software. Mac OS X users can store and archive 
as much as four hours of high-quality DVD 
video, up to 16 hours of VHS video or up to 
8.5GB of data, music or photos on a single 
double layer DVDR disc. User group special 
price of $99, which is a $30 savings off regular 
price. Purchase by calling 503-844-4500 x2 
Promo code: MUGS or go to: www.lacie.com/
us/products/product.htm?pid=10113 .This offer is 
valid through April 30, 2008.
RadTech manufactures and distributes an array 
of best-in-class accessory solutions for Apple 
Computers, iPhone, iPod and Cinema Displays, 
all designed to keep you connected and pro-
tected in style. Most items are made in the USA, 
in-stock and shipped same day. Experience 
the RadTech difference through their unique 
product line and legendary customer support. 
Apple User Group members get 20% off all 
products, except Special Deals, Westone and 
Seagate products. www.radtech.us. Redeem the 

PayPal: 
Steer clear of Safari
by Robert McMillan
If you're using Apple's 
Safari browser, PayPal has 

some advice for you: Drop it, at least if you 
want to avoid online fraud.

Safari doesn't make PayPal's list of recom-
mended browsers because it doesn't have 
two important anti-phishing security fea-

tures, according to Michael Barrett, PayPal's 
chief information security officer.

"Apple, unfortunately, is lagging behind 
what they need to do, to protect their cus-
tomers," Barrett said in an interview. "Our 
recommendation at this point, to our cus-
tomers, is use Internet Explorer 7 or 8 when it 
comes out, or Firefox 2 or Firefox 3, or indeed 
Opera."

Safari is the default browser on Apple's 

Macintosh computers and the iPhone, but it 
is also available for the PC. Both Firefox and 
Opera run on the Mac.

“Unlike its competitors, Safari has no 
built-in phishing filter to warn users when 
they are visiting suspicious Web sites,” 
Barrett said. Another problem is Safari's lack 
of support for another anti-phishing tech-
nology, called Extended Validation (EV) cer-
tificates. This is a secure Web browsing 

technology that turns the address bar green 
when the browser is visiting a legitimate 
Web site.

When it comes to fighting phishing, 
"Safari has got nothing in terms of security 
support, only SSL (Secure Sockets Layer 
encryption), that's it," he said. Apple repre-
sentatives weren't immediately available to 
comment on this story.

An emerging technology, EV certificates 

as well as the traditional .jpg format, have 
full manual-operation capability and even a 
wireless extension flash for use with telephoto 
lenses.

Finally, the SLR Series cameras are fully-
capable digital single-lens reflex cameras. New 
digital specific lenses have better covering 
power for the larger (now half 35mm size) 
CCD chips in these cameras, reducing falloff of 
brightness from the center outward. With self-
cleaning CCD sensors and loads of other fea-
tures appreciated by advanced users, an E420 
might be called a digital OM-1, and is capable 
of using even older Olympus mechanical lenses 
(from film cameras). The mechanical image 
stabilization (the E510, for instance) is in the 
camera body, useful for any lens attached to 

the camera, from your older OM lenses to the 
latest 50mm f/2.8 pancake lens.

Brad Berger traced the history of the 
Berger Brothers Camera Store from its begin-
nings in Amityville back in 1951 to its cur-
rent two stores. Emphasizing come and learn 
with us, the company survives by offering very 
wide inventory and patient customer support. 
Brad showed an assortment of accessories for 
digital cameras, and turned the presentation 
over to Yvonne Berger, who described the 
digital photo courses the store offers. From 
Digital Photo 101 to more advanced courses 
in Photoshop Elements, Photoshop, Collage and 
Retouch, and more. The program broadens 
your capabilities by having you shoot as you 
learn.
–Sam Storch

March’s Meeting (Continued)

The LIMac On-Line Forum/APRIL 2008

how easy it is to use Dictate right out of the 
box, with the included high quality headset, 
in the applications you use every day like MS 
Word, Adobe Photoshop, QuarkXPress and many 
of Apple’s own apps like iChat, Mail, iPhoto, 
Keynote and more. He’ll also demonstrate how 
you can control your Mac with Dictate, instead 
of using the mouse or keyboard.

If you’re tired of typing or need to correct 
a physical condition or handicap, MacSpeech 
Dictate may just be the solution you've been 
waiting for.

Prior to the official start of the general 
meeting, there will be a short video presenta-
tion on the genealogy application, Reunion 9.

 Then the usual meeting agenda will pre-
cede the MacSpeech demo and will include 
Bradley’s Q&A (and the MacBasics Q&A). 
Following the main presentation, we'll hold 
our raffle and then our SIGs will begin their 
sessions.

This promises to be an information-packed 
meeting that you won’t want to miss! 

See you there! 0 –Rick Matteson 

(AprilMeeting continues from Page 1) (Users Group News continues from Page 4)

(Users Group News continues on Page 7)

(Cont. from Page 5)

(Continues on Page 7)

(March’s Meeting continues from Page 1)
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inal value, enter 
the commands 
again with the 
value 0.75.
–Joe Kissell

Troubleshoot 
Spaces with Dock 
Restart: 
If you start having 
problems with 
Spaces and don’t 
want to reboot your 
Mac, try going to 
Terminal and typing 
killall Dock. The 
Dock will restart 
and, with it, Spaces. 
(Alternatively, you 
can also restart the 
Dock from Activity 
Monitor.)
–Rob Griffiths

Assign All Exposé 
Modes to a Single 
Key - By default, 
Exposé’s three 
modes:
All Windows, 
Application Windows, 
and Show Desktop 
are assigned to 
three different 
function keys. If 
you’re running 
short on function 
keys, you can 
assign those three 
modes to a single 
key with modifiers. 
Open the Exposé & 
Spaces preference 
pane and switch to 
the Exposé tab. 
Choose your first 
basic shortcut key; 
I use F3, which I 
assigned to Show 
Desktop. Then hold 
down a modifier 
key, such as option, 
and select the same 
function key from 
the All Windows 
pop-up menu; that 

modifier key is now 
part of the shortcut. 
Finally, hold down a 
different modifier 
key, or combination 
of modifier keys, 
and assign the 
same function key 
to Application 
Windows.
–Dan Frakes 

Dashboard
Widgets on the 
Desktop: 
Like Tiger, Leopard 
lets you move wid-
gets from Dash-
board to the 
desktop; thanks to 
Web Clip, that can 
be more useful than 
ever.
Show Widgets on 
the Desktop: 
If you want to have 
a widget available 
from the desktop, 
not just Dashboard, 
turn on Dashboard’s 
developer mode. 
(You could do this 
in Tiger, but thanks 
to Web Clip and the 
ability to create 
your own custom-
ized widgets, it’s 
more useful than 
ever in Leopard.) In 
Terminal, enter 
defaults write com.
apple.dashboard 
devmode YES, press 
return, and type kil-
lall Dock. That done, 
press F12 to fire up 
Dashboard. Click on 
any widget and 
begin dragging it. 
Without releasing 
the mouse button, 
press F12 again. 
The widget should 
move out of the 
Dashboard layer and 
onto the desktop, 
floating above all 

http://www.volitans-software.com
http://www.lacie.com/us/products/product.htm?pid=10113
http://www.lacie.com/us/products/product.htm?pid=10113
http://www.radtech.us
http://www.olympusamerica.com/cpg_section/cpg_digital_slr.asp
http://www.olympusamerica.com/cpg_section/lens/dea/products/lens/index.asp
http://www.olympusamerica.com/cpg_section/product.asp?product=1372
http://www.mir.com.my/rb/photography/hardwares/classics/olympusom1n2/om1/
http://www.olympusamerica.com/cpg_section/product.asp?product=1295
http://www.berger-bros.com/classes/
http://www.berger-bros.com/classes/
mailto:brad5205@aol.com
http://www.google.com/calendar/event?eid=b2J1bDc5MHY5Nm5pdjBndDNqOGNkaGlma2MgcDBmYzQxMzN2OW1kbjc0djZnMXE4dDhxYmNAZw&ctz=America/New_York
http://www.google.com/calendar/event?eid=aWh1c3R2MTV2ZHYyY29sNWsxOTJiaWV0NWcgcDBmYzQxMzN2OW1kbjc0djZnMXE4dDhxYmNAZw&ctz=America/New_York
http://www.google.com/calendar/event?eid=Y3F0bmI0a3JkM3Q0NGtpaDRtN3BkZWljcWcgcDBmYzQxMzN2OW1kbjc0djZnMXE4dDhxYmNAZw&ctz=America/New_York
http://www.google.com/calendar/event?eid=ajd0ZTRsbzBvcDBtdDljcjFsc2J0a25ja2cgcDBmYzQxMzN2OW1kbjc0djZnMXE4dDhxYmNAZw&ctz=America/New_York
http://download.mozilla.org/?product=firefox-3.0b5&os=osx&lang=en-US
http://www.mozilla.com/products/download.html?product=firefox-2.0.0.13&os=osx&lang=en-US
http://opera.gundari.net/mac/926/Opera_9.26_Setup.dmg
http://en.wikipedia.org/wiki/Extended_Validation_Certificate
http://www.leisterpro.com/doc/whatisreunion.php
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Safari is based on the Konquerer web browser and KDE which does support EV certificates, so one can expect a future version of Safari to address this issue.
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discount: RTAUG108 This offer is valid through 
April 30, 2008.
Serene Saver 2 HD is a unique cross between 
a video desktop (moving wallpaper) and a tra-
ditional screen saver. It brings a bit of serenity 
to your daily life. Actual nature scenes play as 
real movies on your desktop while you work. 
This user group special offers single-user Serene 
Saver for $19.95, regularly $29.95, or $33.27 for 
5 computers, regularly $49.95, or $66.57 for a 
site license, regularly $99.95. Download to test, 
or purchase: www.serenesaver.biz Promotion 
code: SER2UG2008 This offer is valid through 
April 15, 2008.
LH Computer Services offers SATABeast Xi 

extreme density, energy efficient data storage 
for Xserve and MAC Pro Systems. You can get 
up to 42 TB of RAID storage in only 4U of rack 
space. AutoMAID energy-saving technology 
greatly reduces power consumption and cooling 
costs. Full Enterprise Class performance, reli-
ability, and management, plus dual function 
4GB Fibre Channel and iSCSI connectivity. 
These are ultra-high-end, high-capacity data 
storage units for businesses and professionals 
that need to store terabytes of data. User group 
members get 30% off MSRP of units priced 
from $25,000-$75,000. Contact the company 
at 954-752-5805 to discuss your needs with 
a professional consultant. Give coupon code 
LH-APPLE-UG when ordering. 0

are already supported in Internet Explorer 7, 
and they've been used on PayPal's Web site for 
more than a year now. When IE 7 visits PayPal, 
the browser's address bar turns green – a sign 
to users that the site is legitimate. Upcoming 
versions of Firefox and Opera are expected to 
support the technology.

But EV certificates have their critics. Last 
year, researchers at Microsoft and Stanford 

University published a study showing that, 
without training, people were unlikely to 
notice the green address-bar notification pro-
vided by EV certificates.

Still, Barrett says data compiled on PayPal's 
Web site show that the EV certificates are 
having an effect. He says IE 7 users are more 
likely to sign on to PayPal's Web site than 
users who don't have EV certificate tech-
nology, presumably because they're confident 

that they're visiting a legitimate site.
Over the past few months, IE 7 users have 

been less likely to drop out and abandon the 
process of signing on to PayPal, he said. "It's a 
several percentage-point drop in abandon-
ment rates," he said. "That number is... mea-
surably lower for IE 7 users."

Opera, IE, and Firefox are "safer, precisely 
because we think they are safer for the 
average consumer," he added. "I'd love to say 

that Safari was a safer browser, but at this 
point it isn't." 0

The LIMac On-Line Forum/APRIL 2008

(Q&A continues from Page 3)

| We just got a new Mac laptop and we 
understand we can run Microsoft Windows 
and Apple’s operating system together. Is 
that hard to do?
There are a few ways to go. Leopard comes 
with a Boot Camp installer, which walks you 
through burning a driver CD and partitioning 
your hard drive and installing your own copy 
of Windows XP Pro service pack 2 or Windows 
Vista Business on this new partition. To use 
Windows (either one) you have to restart, 
specify the boot partition and then you are 
running Windows and not the Mac OS X. This 
method is the cheapest and the fastest and 
most compatible, but also inconvenient, 
because you have to stop everything on the 
Mac side and restart to run Windows, you can’t 
have both at the same time. The other option 
is to buy either of two inexpensive ($80) pro-
grams, either Parallel’s Desktop 3.0 for Mac or 
VMware’s Fusion 1.1. These are called virtual-
ization products as you can run Windows 
within (a window) the Mac OS X. You can 
print, access the Internet, exchange files from 
Mac OS X to Windows. Each product has it’s 
strengths and weaknesses and some people 
will tell you one is faster than the other but it’s 
very dependant on the programs you need to 
use under Windows. Windows Vista will run 
quite a bit slower than Windows XP, and you 
can turn off the eye candy within Windows’ 
control panel to speed them up. You can even 
have Windows  take over the whole screen. 

(Cont. from Page 6) 

(Continues from Page 6)

These virtual environments can use the same 
data sitting on your Boot Camp partition, so 
you can use them when convenience is para-
mount, or restart as real Windows when 
needed. There is a small performance hit when 
running virtually, but for many things it’s not 
noticable. Believe it or not, the MacBook/
MacBook Pro makes for a pretty decent 
Windows machine, particularly the MacBook 
Pro models, as they have a dedicated graphics 
chip. It’s mostly games that require the 
advanced driver support possible with the Boot 
Camp option. As Apple’s laptops don’t have 
two buttons with the trackpad, you’ll probably 
want a wired or wireless mouse. If you are run-
ning a virtual environment, you will need 
more RAM memory than normal, as you will 
be supporting two operating systems at once. 
I’d max out the computer to a full 4GB of 
RAM. As for ease of use, it’s easier to install 
Windows under Parallels Desktop than on a real 
PC.
| Can someone running Windows get the 
information I create with the Mac? I do 
bookkeeping for other people.
Sure, it’s just like you are running any other 
Windows machine. If the other person has a 
compatible version of the software you use, 
then it’s no problem. If you use, say 
QuickBooks Pro 2008 or MYOB Plus under 
Windows XP, then someone using the same 
generation on their Windows machine, should 
have no problem reading the files you edit. You 
can use a Windows-formatted USB flash drive 
or burn a CD or e-mail the files. 0

(Users Group News continues from Page 6)

other windows. If 
you want more con-
trol over the way 
your widgets work 
outside Dashboard, 
use Amnesty Widget 
Browser or Amnesty 
Singles ($20 and 
$10, respectively).
–Joe Kissell

Launch Dashboard 
with the Mouse:
 If you have a multi-
button mouse and 
want to avoid using 
the keyboard just 
to invoke Dash-
board, assign a 
mouse button to it 
instead. Let’s say 
you have an Apple 
Mighty Mouse. Go 
to the Keyboard & 
Mouse preference 
pane and click on 
the Mouse tab. Then 
choose Dashboard 
from the pop-up 
menu corre-
sponding to one of 
the buttons (I sug-
gest either the 
scroll-ball button or 
squeezing the 
mouse). If you use 
a third-party mouse 
with its own soft-
ware, follow the 
manufacturer’s 
instructions for 
configuring its 
extra buttons.
–Joe Kissell

	
Del.icio.us
Resize Web Clip 
Widgets:
If you use Safari’s 
new Web Clip fea-
ture to make a 
Dashboard widget 
out of a small Web 
item, you may be 
dismayed to find 
that Safari enforces 
a minimum size of 
about 128 by 128 
pixels; you can’t 
make the Web Clip 
selection smaller 
than that. The solu-
tion is simple if not 
obvious: after cre-
ating the widget, 
click on the I on 
the widget’s face 
and then click on 
Edit. You’ll be able 
to resize and 
reframe the widget 
as you wish.
–Rob Griffiths

http://www.serenesaver.biz
http://www.apple.com/macosx/features/300.html#bootcamp
http://www.parallels.com/en/products/desktop/
http://www.vmware.com/products/fusion/
http://www.nexsan.com/satabeastxi/
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